Excel Reports

Excel reports output a downloadable Excel spreadsheet that contains the defined data set and any templates,
charts, tables, or other elements added to the customized Excel template. Excel reports use the Report wizard's
filters and groupings/summaries, and once the report parameters have been defined in the rest of the wizard, you
can download the Excel template in the Customize Excel tab of the Report wizard and begin to customize it. For
example, after defining the data, filters, groupings, and other parameters, you might customize the template to
include a PivotTable analyzing the data, and a PivotChart to display the results at a glance.
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Example Excel report

Unlike graphical, HTML, and text reports, Excel reports can pull data from multiple tables. You can then use
PivotTables and charts to analyze the data in any combination. To create an Excel report with data from multiple
tables, configure an Excel report in each table with the data you want to use, and then create a combined report
that uses those reports as data sources.

® Excel reports look different from other reports, so if you haven't worked with them before, we recommend
exploring the Example Reports before you begin.

Example Reports

Before you create your own Excel reports, it can be helpful to explore an example to see how these reports work
differently from graphical charts, custom summary reports, or HTML and text reports. In this section, you can follow
a guided tour of two example Excel templates.


https://wiki.agiloft.com/display/HELP/Create+and+Edit+Charts+and+Reports#CreateandEditChartsandReports-Filter
https://wiki.agiloft.com/display/HELP/Create+and+Edit+Charts+and+Reports#CreateandEditChartsandReports-Grouping/Summary
https://wiki.agiloft.com/display/HELP/Create+and+Edit+Charts+and+Reports#CreateandEditChartsandReports-CustomizeExcel

Single-Source Example

Let's begin with a simple example template that pulls data from a single source.

1. Download Contracts Excel Dashboard.zip, extract the Excel file, and open it.

2. Explore the contents of the Sample Dashboard worksheet. This worksheet arranges all the configured charts
onto one screen to function as a dashboard.

3. Click through the next worksheets, which each contain one of the charts shown on the Sample Dashboard
worksheet. In this example, each chart is placed with its corresponding PivotTable on its own worksheet, and
duplicated on the Dashboard worksheet. Keeping PivotTables separated can help prevent problems and
make maintenance easier.

4. Open the last worksheet, titled Data. This worksheet contains the data pulled by the report and placed into
the Excel file. The columns are determined by the report's defined view, and the records included are
determined by the report parameters. The charts and PivotTables we explored in steps 2 and 3 refer to this
worksheet, so it's important to preserve the layout and format of the Data worksheet. For example, if
someone updated the view for this report and removed the Contract Start Date, several of the charts would

break.

To create a similar single-source Excel report, complete the steps in the Create a Basic Excel Report and the
Customize the Excel Template sections.

Multi-Source Example

Now, let's explore a more complex example that pulls data from four sources.

1. Download Combined Dashboard.zip, extract the Excel file, and open it.

2. Explore the contents of the Dashboard worksheet. This worksheet arranges several charts onto one screen
to function as a dashboard.

3. Open the next worksheet, Pivot Tables. This example places all the PivotTables onto a single worksheet.
These tables are used to create the charts on the Dashboard worksheet. When the template includes several
automatically-created Data worksheets, you might find it helpful to concentrate your PivotTables onto a
single shared worksheet to make the file easier to navigate.

4. Click through the last four worksheets, titled Datal, Data2, Data3, and Data4. Each worksheet contains the
data pulled by one of the specified source reports. Each worksheet has its own set of columns defined by the
view of the source report, and the records included are determined by the source report parameters. The
charts and PivotTables we explored in steps 2 and 3 refer to these worksheets, so it's important to preserve
the layout and format of the Data worksheet, and not to change the order of the source reports after you've

configured the Excel template.


https://wiki.agiloft.com/download/attachments/58360200/Contracts%20Excel%20Dashboard.zip?version=1&modificationDate=1541431221925&api=v2
https://wiki.agiloft.com/download/attachments/58360200/Combined%20Dashboard.zip?version=1&modificationDate=1541431221990&api=v2

To create a similar multi-source Excel report, create a basic Excel report for each source table. Then, create a
combined report using the basic reports you created, and finally complete the steps to Customize the Excel
Template.

Create a Basic Excel Report

In general, report parameters depend heavily on your specific reporting needs. When you set up an Excel report,
there are additional considerations for certain parameters.

@ If you're planning to create a combined Excel report with data from several tables, you need to configure an
Excel report in each table that identifies the data using the steps in this section. Make sure you configure a
report in each table you want to include in your final report.

Create a View for the Report

The view you choose for an Excel report determines how the report data is imported and formatted into the Data
worksheet of the final file. All your template customization will rely on the column arrangement of the Data
worksheet, so it is important to configure the view correctly the first time you set up the report, to avoid accidentally
breaking the report.

1. Before you begin, determine the purpose of this view. Specifically, decide whether the view will be used
outside of Excel reporting, and whether the view will be used for just this report or for multiple Excel reports.

@ We recommend creating a view specifically for Excel reports that is not used in the normal table
view. If you are comfortable working with Excel, you might be able to create one view to use in all
Excel reports for the table; this requires including more data than you need for any individual report
and combing through the data in Excel later. If you are less comfortable working with lots of data in
Excel, or if your system has an unusually large amount of data, you should consider creating
individual views for each Excel report you create.

2. Either from the Grouping/Summary tab in the Report wizard or from the table you are reporting on, create a

new view.

Show records?

) Do not show records

® Show records using view selected below
View for showing record: Report View hd

Show not more than 100 ¥ records in each grouping

Show records using selected view



3. If you plan to use this view only for Excel reports, clear the check boxes for selection, edit, and view icons. In
Excel, these icons don't do anything.

4. Set Max lines per record and Max lines per linked field to all. This makes sure the complete value is sent to
Excel.

5. Check the Display check box for the appropriate fields, with the following considerations:

= |f you aren't sure whether you need a field, it's better to include it. You can always ignore the data in
Excel, but it's difficult to add fields to the view after you create an Excel report.

= |f you plan to use this view for other Excel reports, select every field you might need in any of those
reports. If you don't select a field, your Excel reports will not receive any data for that field.

® Always include the ID field and, if possible, a second field with unique values, such as the summary
field.

6. Go to the Order/Colors tab and configure the field order. This corresponds to the order of the columns in the
Excel data worksheet. We recommend putting the ID field and other important fields on the left, just like you
do for regular views.

7. If you plan to use this view outside of Excel, configure row coloring or notification icons as desired. If you
plan to use this view only for Excel reports, you can configure row coloring directly in Excel later.

8. Go to the General tab and name the view. Include "DO NOT EDIT" in the name to help prevent users from
accidentally editing the view and breaking the report. If you plan to use this view only for Excel reports or
only for a specific Excel report, mention that in the name as well.

9. Set the Maximum View Width to a high value, such as 900 characters. You can adjust the column width in
Excel later.

10. Set the Records Per Page to the highest value available.
11. Go to the Apply tab and make the view visible to every group that needs to view or edit the Excel report.

Set Up the Report

With your view ready to go, set up your Excel report as desired, with the following options:

® |f you're using this report to create a combined report, on the General tab, make sure the report title mentions
the table name. For example, you might name your report "Service Requests Data for Combined Dashboard".

® On the Filter tab, leave the saved search set to None. Results can be filtered using a PivotTable in Excel, so
usually a saved search filter isn't necessary.

® On the Grouping/Summary tab, select the view you created and set a high value in Show not more than X
records in each grouping, such as 100,000. This determines how many records are sent to Excel.

® |f you aren't using this report to create a combined report, when you reach the Customize Excel tab, click
Create/Download New Excel File and proceed to the Customize the Excel Template section. If you're using

this report to create a combined report, you can skip the customized template.



Combined Reports

If you're creating a combined Excel report with data from many tables, the first step is creating individual Excel
reports in each table you'll use as a data source. For example, if your combined report includes data from the
Service Requests, Incidents, Problems, and Change Requests tables, you need to create an Excel report in each of
those tables to identify the data set you want to use. For more guidance on creating usable Excel reports, refer to
the Excel Report Parameters section.

After you create all the necessary source reports, your next step is creating a combined report that pulls from the
other reports you created.

1.

In Agiloft, click the Menu icon and click Summary/combined reports. If Summary/combined reports is not
available, follow the steps below:
a. Navigate to Setup > Look and Feel > Navigation Menu.
b. Edit the Navigation Menu record that correlates to the users who you would like to be able to run
reports.
Navigate to the Content tab.
In Available Items, select Summary/combined reports.
Click Add.
Click Next.
g. Click Finish.
h. Now, click the Menu icon and click Summary/combined reports.
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2. Click New.
3. Give your report a title and description. Make sure the description lists the tables you're using to provide

No o &

source data.
Select the Excel output format.
Go to the Select Reports tab and click New.

In the Combined Report wizard, select the table and then select the Excel report you created. Click Finish.

Repeat step 6 for each table and Excel report you want to include. Each one you select will create a
separate Data worksheet in the Excel file.

@ The reports are sent to the Excel template in the same order they're listed here. If you want to
change the order, click and drag to move the reports.

8. Go to the Customize Excel tab.

9. Click Create/Download New Excel File and proceed to the Customize the Excel Template section.

10.

When you finish your Excel template, configure the Schedule and Apply tabs as needed. For details, see

Create and Edit Charts and Reports.


https://wiki.agiloft.com/display/HELP/Create+and+Edit+Charts+and+Reports

Customize the Excel Template

After you configure the first set of report parameters, you need to create a template the system will use to generate
your Excel reports. When a report is generated, your template is replicated exactly with the exception of the Data
worksheet. The Data worksheet is replaced with new data from the system, pulled in using the parameters and view
you configured. The rest of your template is automatically refreshed so the new data is applied.

! This section includes tips for working in Excel, but some functionality might be slightly different depending
on the version of Excel you are using. For additional help working with Excel, or for information about more
advanced Excel features, refer to Microsoft Office support.

1. Inthe Customize Excel tab, click Create/Download New Excel File to download the report with the current
parameters.

2. If necessary, customize the column width and text wrapping on the Data worksheets to make them readable.
Important: Do not rename Data, Datal, Data2, or similarly named worksheets. The system uses these
worksheet names to generate the report correctly.

3. Add any necessary customization to create your report.

® Create new worksheets for your tables, charts, and dashboards as needed
® Create PivotTables and PivotCharts on the new worksheets
® Set the design and colors appropriately

®  Arrange charts and tables to make the report easy to use
. Save the file.
. Click Choose File and select the Excel report.
. Click Upload Customized Excel File.

. Test the report thoroughly and make adjustments as needed.
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. When the report is next run according to the schedule, the system will take the run-time data and apply it to
the new Excel report template.

This approach provides a high level of customization using advanced Excel features such as pivot tables, which
allow you to segregate a lot of different data into easy views for granular analysis. In this case, Agiloft simply
provides the report data, and the template handles all of the presentation and formatting requirements. This
requires the person building the template to have familiarity with advanced Excel functions.

Detailed Excel Customization Example

If you haven't worked with Excel in the past, you can use this section to learn how to make a basic Excel report
using your data. Note that this section assumes you have already completed the steps in Agiloft to determine your
report parameters and specify what data to pull from the system.


https://support.office.com/en-us/article/Create-a-PivotTable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-f99134456576?ui=en-US&rs=en-US&ad=US&fromAR=1
https://support.office.com/en-us/excel

Note that the steps refer to the Data worksheet, but if you are working on a combined report, you will have multiple
Data worksheets that the steps apply to.

1.
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In the Customize Excel tab, click Create/Download New Excel File to download the report with the current
parameters.

On the Data worksheet, see how your report looks. The Data worksheet is overwritten each time the report is
run, so we won't spend much time on customization here, but you can adjust the column width and turn Wrap
Text on or off. For example, if your Data worksheet includes a working notes field with lots of text, you might
want to turn Wrap Text on for that column to make the text readable, or turn Wrap Text off and make the
column narrow if you don't intend for anyone to read the text in those fields.

When you're satisfied with your Data worksheet formatting, go to Insert > PivotTable.

Make sure the New Worksheet option is selected and click OK.

To keep our report tidy, double-click the Sheetl worksheet at the bottom and rename it PivotTables.
Review the PivotTable Fields list and drag some fields into the rows, columns, and values boxes. You can
use the drop-down arrow to see additional analysis options for the field, and you can create nested fields by
dragging additional fields on top of fields you already added. Experiment with the options until you are
satisfied with your table.

@ If you've never created a PivotTable before, start by dragging the ID field into the Values box. Click
the drop-down arrow in the box and select Value Field Settings, then change the selection from Sum
to Count and click OK. Now, drag another field, such as Status or Priority, into the Rows box.
Finally, drag a third field, such as Assigned Team or Department, into the Filters box. This will give
you a basic table to use for this exercise.

Now that you've created a table, you can create slicers. Slicers make it easy to filter the data without changing the
configuration of the PivotTable. Later, we'll put the slicers on the dashboard next to the corresponding PivotChart,
so we can use our dashboard without looking at the PivotTable at all.

1.

Select a cell inside the PivotTable and go to Analyze > Insert Slicer. Slicers make it easy to filter data
directly in the PivotChart we will create from the table, without having to filter the data out of the report
entirely or having to narrow your report parameters too closely. For example, you might want to be able to
see the number of tickets for a specific team; with a slicer, you can switch between different teams easily,
without removing any data from your report.

If you added a field to the Filters box, select that field for your filter. Otherwise, choose a field such as

Assigned Team or Department.

3. Click OK.
4. With the slicer selected, open the Options ribbon and select a color for this filter. Use the same color for the

same type of filter consistently in your report so that your report is easier to read. For example, if you set a
Priority slicer to dark blue, you should use the same color for Priority slicers in other tables, and not use dark

blue for any other slicers.

5. Right-click inside the PivotTable and click PivotTable Options.

6. Give the table a clear, descriptive name to differentiate it from other PivotTables you might create later.



7. Clear the "Autofit column widths on update" check box. This prevents the column widths from changing
unexpectedly when you run the report.

8. Click OK.

9. Now that the PivotTable is set up, select a cell in the table and open the Design ribbon. Explore the options
to change the presentation of the table. For example, change the Report Layout to Tabular Form and see

what changes. Play around with these settings to find the best design for your report.
With the PivotTable finalized, it's time to create a chart and build our dashboard.

1. Goto Analyze > PivotChart. Select one of the simple charts, such as a basic bar or line graph, and click OK.
2. We want to show our chart on a dashboard, not the PivotTable worksheet. Right-click the worksheet farthest
on the left and click Insert. Click OK to add a worksheet, double-click the new worksheet, and rename it
Dashboard.

Go back to the PivotTables worksheet. Right-click the chart and click Cut.

Go back to the Dashboard worksheet and Paste the chart.

Cut the slicer from the PivotTables worksheet and Paste it on the Dashboard worksheet.
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Arrange the chart and the slicer together on the page.
The dashboard is starting to come together. Now, clean up the look of the chart:

1. Right-click the field buttons in the upper-left corner and click Hide All Field Buttons on Chart.

2. Open the Design ribbon and select a default chart design.

3. Right-click a data point on the chart and click Format Data Series. Open the paint bucket tab, expand the
Fill options, and select the Vary colors by point check box.

4. Open the Design ribbon and click Add Chart Element to add or remove any chart element as needed. For
example, if the axis labels and the legend show the same information, you could change the Legend element
to None.

5. Adjust the format of the chart as needed by right-clicking the element you want to change and opening the

options for that element.
Finally, clean up the dashboard:

1. Select a cell outside the chart and slicer.
2. Open the View ribbon and clear the Gridlines check box.
3. Open the Home ribbon and use the paint bucket tool to fill in the background with a contrasting color, like

dark gray.

Now, you have a basic Excel report with a dashboard and a worksheet for PivotTables. You can add new tables
and charts to your report using the same steps as above.

@ If you add more than one PivotTable in the same worksheet, place the tables in a row horizontally rather
than stacking them vertically. If you run the report and a lot of data is found, the tables might become much
longer than you expected, and if they are placed in a column, upper tables will overwrite lower tables and
break them.
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